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Copyright and Trademarks 
Copyright © 1995, 2009, Oracle and/or its affiliates. All rights reserved. 

This software and related documentation are provided under a license agreement containing 
restrictions on use and disclosure and are protected by intellectual property laws. Except as 
expressly permitted in your license agreement or allowed by law, you may not use, copy, 
reproduce, translate, broadcast, modify, license, transmit, distribute, exhibit, perform, publish or 
display any part, in any form, or by any means. Reverse engineering, disassembly, or decompilation 
of this software, unless required by law for interoperability, is prohibited. 

The information contained herein is subject to change without notice and is not warranted to be 
error-free. If you find any errors, please report them to us in writing. 

If this software or related documentation is delivered to the U.S. Government or anyone licensing it 
on behalf of the U.S. Government, the following notice is applicable: 

U.S. GOVERNMENT RIGHTS 
Programs, software, databases, and related documentation and technical data delivered to U.S. 
Government customers are "commercial computer software" or "commercial technical data" 
pursuant to the applicable Federal Acquisition Regulation and agency-specific supplemental 
regulations. As such, the use, duplication, disclosure, modification, and adaptation shall be subject 
to the restrictions and license terms set forth in the applicable Government contract, and, to the 
extent applicable by the terms of the Government contract, the additional rights set forth in FAR 
52.227-19, Commercial Computer Software License (December 2007). Oracle USA, Inc., 500 
Oracle Parkway, Redwood City, CA 94065. 

This software is developed for general use in a variety of information management applications. It is 
not developed or intended for use in any inherently dangerous applications, including applications 
which may create a risk of personal injury. If you use this software in dangerous applications, then 
you shall be responsible to take all appropriate fail-safe, backup, redundancy and other measures 
to ensure the safe use of this software. Oracle Corporation and its affiliates disclaim any liability for 
any damages caused by use of this software in dangerous applications. 

Oracle is a registered trademark of Oracle Corporation and/or its affiliates. Other names may be 
trademarks of their respective owners. 

This software and documentation may provide access to or information on content, products and 
services from third parties. Oracle Corporation and its affiliates are not responsible for and 
expressly disclaim all warranties of any kind with respect to third party content, products and 
services. Oracle Corporation and its affiliates will not be responsible for any loss, costs, or damages 
incurred due to your access to or use of third party content, products or services. 
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Preface 
The Agile PLM documentation set includes Adobe® Acrobat PDF files. The Oracle Technology 
Network (OTN) Web site http://www.oracle.com/technology/documentation/agile.html contains the 
latest versions of the Agile PLM PDF files. You can view or download these manuals from the Web 
site, or you can ask your Agile administrator if there is an Agile PLM Documentation folder available 
on your network from which you can access the Agile PLM documentation (PDF) files. 

Note To read the PDF files, you must use the free Adobe Acrobat Reader version 7.0 or later. 
This program can be downloaded from the Adobe Web site http://www.adobe.com. 

The Oracle Technology Network (OTN) Web site 
http://www.oracle.com/technology/documentation/agile.html can be accessed through Help > Manuals 
in both Agile Web Client and Agile Java Client. If you need additional assistance or information, 
please contact support http://www.oracle.com/agile/support.html 
(http://www.oracle.com/agile/support.html) for assistance. 

Note Before calling Oracle Support about a problem with an Agile PLM manual, please have 
the full part number, which is located on the title page. 

TTY Access to Oracle Support Services 

Oracle provides dedicated Text Telephone (TTY) access to Oracle Support Services within the 
United States of America 24 hours a day, 7 days a week. For TTY support, call 800.446.2398. 
Outside the United States, call +1.407.458.2479. 

Readme 

Any last-minute information about Agile PLM can be found in the Readme file on the Oracle 
Technology Network (OTN) Web site http://www.oracle.com/technology/documentation/agile.html

Agile Training Aids 

Go to the Oracle University Web page 
http://www.oracle.com/education/chooser/selectcountry_new.html for more information on Agile 
Training offerings. 
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Accessibility of Code Examples in Documentation  

Screen readers may not always correctly read the code examples in this document. The 
conventions for writing code require that closing braces should appear on an otherwise empty line; 
however, some screen readers may not always read a line of text that consists solely of a bracket or 
brace.  

Accessibility of Links to External Web Sites in Documentation  

This documentation may contain links to Web sites of other companies or organizations that Oracle 
does not own or control. Oracle neither evaluates nor makes any representations regarding the 
accessibility of these Web sites.  

 





 

Chapter 1 

Resolved Issues 

This chapter includes the following: 

 Install and Test Notice ......................................................................................................................................... 7 
 Oracle|Agile Patch Note ...................................................................................................................................... 7 
 Administration ...................................................................................................................................................... 8 
 Common Services ............................................................................................................................................... 10 
 Integration............................................................................................................................................................ 21 
 Portlets................................................................................................................................................................. 24 
 Product Collaboration .......................................................................................................................................... 24 
 Product Cost Management .................................................................................................................................. 30 
 Product Portfolio Management ............................................................................................................................ 32 
 Product Quality Management .............................................................................................................................. 38 
 Technology Platform............................................................................................................................................ 39 

This section lists issues that were resolved during this release. Numbers in bold (for example, 
123456) are Customer Support ID numbers from customer-reported issues. 
 

Install and Test Notice 
Important Install and test this release on a designated development server before installing it on 

your production environment. Your development environment should mirror your 
production environment as closely as possible to provide accurate testing results. It is 
important to validate the installation of this release, and confirm your integrations are 
working correctly as part of your minimum due diligence. Any problems or questions 
noted during your development system testing should be resolved before installing this 
release on your production environment. 

 

Oracle|Agile Patch Note 
Note The contents of this release include the following Patches: Oracle|Agile PLM 9.2.1.3.54, 

9.2.1.4.27, 9.2.1.5.1, 9.2.2.1.21, 9.2.2.1.22, 9.2.2.1.24, 9.2.2.1.25, 9.2.2.1.26, 9.2.2.1.27, 
9.2.2.1.28, 9.2.2.1.29, 9.2.2.2.22, 9.2.2.2.23, 9.2.2.2.24, 9.2.2.2.25, 9.2.2.2.26, 9.2.2.2.27, 
9.2.2.2.28, 9.2.2.2.30, 9.2.2.2.31, 9.2.2.2.32, 9.2.2.2.33, 9.2.2.2.35, 9.2.2.2.37, 9.2.2.2.38, 
9.2.2.3.10, 9.2.2.3.11, 9.2.2.3.12, 9.2.2.3.13, 9.2.2.3.14, 9.2.2.3.15, 9.2.2.3.16, 9.2.2.3.17, 
9.2.2.3.18, 9.2.2.3.19, 9.2.2.3.20, 9.2.2.3.21, 9.2.2.3.21, 9.2.2.3.23, 9.2.2.3.9, 9.2.2.4.10, 
9.2.2.4.12, 9.2.2.4.13, 9.2.2.4.14, 9.2.2.4.15, 9.2.2.4.16, 9.2.2.4.17, 9.2.2.4.19, 9.2.2.4.2, 
9.2.2.4.20, 9.2.2.4.4, 9.2.2.4.5, 9.2.2.4.5, 9.2.2.4.8, 9.2.2.4.9, 9.2.2.5.1, and 9.2.2.5.2. 
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Administration 
18997430.6, 19008454.6, 19011324.6

Administration/Configuration 

Issue: Importing privilege with custom flex fields breaks the Read/Modify privileges. 

Root Cause: The system was using name instead of ID in AppliedTo. 

Verification: Follow the steps below to verify the resolution: 

 In a test environment 1:  

1. Create a custom flex field.  

2. Create a Read privilege to read the new custom flex field.  

3. Export this Read privilege.  

 In a second test environment:  

4. Create the same custom flex field.  

5. Import the privilege and the privilege can be imported successfully. 
 

 

19002736.6

Administration/Configuration 

Issue: User is unable to log into PLM successfully. 

Verification: Follow the steps below to verify the resolution: 

1. Log into Java Client, create a list “test” and four list entries for it: a, b, c, and d. 

2. Open list “test”, delete list entry a, and disable list entry b. 

3. Restart the application server and make sure that the application server can re-start successfully 
and the OC4J log file has no exception. 

4. Log into Java Client, create a cascading list name it as “Cas”, and add four list entries for it: A, B, 
C, D. 

5. Enable P2.Multilist01 for Change Orders and assign “Cas” to it. 

6. Create a Change Order, set P2.Multilist01=B, open cascading list “Cas”, delete list entry B and 
then disable list entry D. 

6. Restart the application server, making sure that the application server can re-start successfully 
and the OC4J log file has no exception. 
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19009138.6

Administration/Configuration 

Issue: When a user tries to disable one of the standard Lifecycle Phases there is a message: ORA-
01722: Invalid Number. 

Verification: Follow the steps below to verify the resolution: 

1. Log into Java Client as Administrator. 

2. Go to Classes > Items. 

3. Open Lifecycle Phases. 

4. Select 'Inactive' and click Disable, making sure you can save your modification successfully. 

5. Create a new entry, then save and make sure you can create a new entry for the Lifecycle 
Phases. 

 

 

19010676.6

Administration/Configuration 

Issue: A subclass can be deleted even though a Workflow is using its attribute. 

Root Cause: The deletion routine failed to check for subclass usage in workflow 

Verification: Follow the steps below to verify the resolution: 

1. Log into Java Client as administrator. 

2. Create new Parts subclass 'Part-SubclassX'. 

3. Copy 'Default Change Requests' workflow and name it as 'TEST ECR' workflow.  

4. Modify Exit Required Fields of CCB status of 'TEST ECR' workflow.  

5. Include Page Three attributes of 'Part-SubclassX' and save. 

6. Create Change Status privilege for 'TEST ECR' workflow and assign it to the administrator user. 

7. Remove subclass 'Part-SubclassX'. Make sure that Subclass 'Part-SubclassX' cannot be deleted. 
There will be a pop-up error to remind you the subclass was in use. 

 

 

7455919

Issue: Enhance logging configuration. 

Verification: Follow the steps below to verify the resolution: 

1. Go to Administration. 

2. Click Logging Configuration. 

3. Change the level for class com.agile.util.sql.ConnectionFactory to Debug.  

4. After that, VNC to the server and try to find the log file sql.log under <OAS_HOME>\j2ee\home; 
make sure the file can capture all the SQL statements executed by application. 

 



Readme  
 
 
 

5. Change the level for class com.agile.util.sql.ConnectionFactory to OFF, then do an operation in 
agilePLM, then VNC to the server, find the log file sql.log under <OAS_HOME>\j2ee\home; 
make sure the file did not capture the SQL statements for the operation on Agile PLM. 

 
 

Common Services 
18922598.6, 7095935.993

Searches 

Issue: On a Program the user cannot search all deliverable items. 

Resolution: Now user should be able to search all deliverable 'items' also on Programs. Also, the 
user is provided with an option to select all deliverables available on the Program. 

 

18923878.6, 18981288.6, 19002172.6

Standard Reports 

Issue: The user is unable to execute the Workflow Configuration Report. 

Root Cause: The cell value is larger than 8K. In Microsoft Excel one cell can only contain less than 
8K of text. So a special handle for this case is required to expand the cell value in several cells.  

Resolution: Expand the table by adding several new rows to store those additional split cells. 

Verification: Follow the steps below to verify the resolution: 

1. Log into Java Client and go to Admin > Workflow. 

2. Create a Workflow (or Default Workflow--example Default Change Orders). 

3. In CCM Criteria, select all attributes in 'Entry Required Filed' and ensure this data size is bigger 
than 8K.  

4. Log into Web Client and run the Workflow Report. It should execute and display successfully. 
 

 

18960070.6

Web Client 

Issue: Sorting of numeric fields on search results is incorrect. 

Root Cause: Agile was sorting the numeric field values as text by alphanumeric order. 

Verification: Follow the steps below to verify the resolution: 

1. In Java Client the administrator enables a numeric attribute of a Part, e.g. Page Two.numeric01. 

2. Log into Web Client, create some parts and fill in the Page Two.numeric01 with different values. 

3. Create a search for parts with the output containing the numeric field. 
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4. Run the search in Web Client. 

5. Sort the search result on the numeric field correctly. 
 

 

18963604.6, 19011900.6

Folders, Files and Attachments 

Issue: The File purge functionality is not working properly and fails to perform. 

Resolution: The issue was resolved by the implementation of other fixes. 

Verification: Follow the steps below to verify the resolution: 

Pre-Condition: User needs the following settings in Java Client: Auto Purge Enabled = 'YES' File 
Version Keep = "1" Purge Redlined File = 'YES'. Navigate to Server Settings > Task Configuration > 
Attachment Purging Task Interval is set to 1440 and Loopback window is set to 720. 

1. Log into Web Client. 

2. Create a part and add multiple files into single file folder. 

3. Create a Change against the part and Redline the files. 

4. Bump up the versions multiple times by checking it out and checking it back in. 

5. Navigate to the Show Versions window. 

6. Navigate to the vault and verify the files uploaded into the part. 

7. Delete one redlined file each from version 1 and 2 in the vault. 

8. Set the system time one day later to run the servlet. 

9. Restart the application server. 

10. Navigate to the vault. 

Expected Results: For example, if there are four versions in Show Version window only the latest 
two versions will be displayed. Other files from version 1 and 2 should be moved to Purge folder 
once the purge servlets runs. 

 

18972414.6, 18996360.6

Folders, Files and Attachments 

Issue: Performing a PDX export operation with attachments located on a secondary file manager 
fails due to missing FILE_INFO record. 

Resolution: This issue is related to missing entry in FILES_INFO table. The issue was resolved by 
the implementation of other fixes. 

Verification: Follow the steps below to verify the resolution: 

Pre-condition: UserA with Primary IFS and UserB with DFM. 

1. Log into Web Client with UserA (IFSuser). 

2. Create a part and add attachments. 
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3. Log into Web Client with UserB (DFMuser). 

4. Search for the part added by UserA. 

5. Navigate to Actions menu and click on Export. 

6. The files are added in Primary Vault and files are replicated on Secondary vault. 
 

 

18979554.6

Folders, Files and Attachments 

Issue: The File Description will not let the user include double quotes. 

Root Cause: The first quote (") encountered in the file description is considered as the end of "file 
description". 

Resolution: The issue was resolved by the implementation of other fixes. 

Verification: Follow the steps below to verify the resolution: 

1. Log into Web Client.  

2. Open a part, go to the Attachment tab and click the Add files button. 

3. Choose not to use the advanced file productivity component. 

4. Add a file and type in a file description in double quotes 'filename'. 

5. Click on OK and the file is added with the description entered while uploading the file with quotes. 
 

 

18993926.6, 18999268.6

Standard Reports 

Issue: Item Activity Report is missing data. 

Root Cause: The CMDiscover object build is not correct. 

Resolution: Load the correct CMDiscover object through DiscoverBuilder object. 

Verification: Follow the steps below to verify the resolution: 

1. Log in as administrator and create a user as test_adam2. 

2. Assign some necessary roles for the user such as: My User Profile, Report Manager Backup, 
Report User Backup, Change Analyst, F - Item Creator, F - SOC - Product Content Read Only. 

3. Log in as test_adam2 and run Item Activity Report with the criteria: all items from 10/20/2006 to 
10/26/2007 status: released. It should return " WARNING: There is no data to display."  

4. Log into Java Client with administrator and assign a role: JENNYTEST for test_adam2. (Note: the 
role JENNYTEST just has a privilege "Discover all changes"). 

5. Log in as test_adam2 and re-run the Item Activity report and the data should be returned this 
time. 
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6958521.993

Searches 

Issue: When performing a workflow search with Affected Items output there is the following error: 
ORA-00904 ERROR. 

Verification: Follow the steps below to verify the resolution: 

1. Log into Web Client and create an Advanced Search based on Audits or Non-Conformance 
Reports. 

2. Type: Object Search. 

3. Criteria Condition: [Workflow.Approver Contains $USER AND Workflow. 

Approver Action Equal To Awaiting Approval]. 

4. Customize Output fields to include Affected Item.Item Number or Affected Item.Failure Mode. 

5. Run the search. 

6. View the correct results without an error message. Also works for the other PSR and QCR 
objects. 

 

 

18995274.6

Folders, Files and Attachments 

Issue: The History on a Change Order does not reflect the correct file name for a Check-In. 

Root Cause: UI is making two calls: first check-in of folder followed by updates for Change/Item 
object. During check-in, the system is trying to get file-name from Attachment table of Changes 
which is giving the wrong file name. 

Resolution: Start retrieving file name from folder i/o Attachment table of Changes. 

Verification: Follow the steps below to verify the resolution: 

1. Log into Web Client. 

2. Create a part and add attachments. 

3. Checkout a file in standard mode and navigate to the History tab. 

4. Check-in by replacing the file. 

5. Navigate to the History tab.  

6. The filename is correct in the Details column and the replaced filename is stamped in the History 
tab. 

 

 

19003880.6, 7112050.993

Web Client 

Issue: Invoking URL from Process Extension will override the browser window opened previously. 

Root Cause: The window was being given the same name as the window open, hence URL opened 

 



Readme  
 
 
 

in same window.  

Resolution:  Assign a dynamic name to the window (with the help of date). 

 

19004094.6

Searches 

Issue: The Pending Changes.Change category value is not showing up in the Advanced Search. 

Verification: Follow the steps below to verify the resolution: 

1. Log into Java Client; go to Admin > Classes > Change Orders > Cover Page, and make sure 
cover page.Change Category and Reason Code are enabled. 

2. Go to Admin > Classes > Parts class, Changes tab, Pending Changes and enable Change 
Category and Reason Code attributes. 

3. Create a part and create a pending change for this part. 

4. In the pending change enter values for Change Category and Reason Code. 

5. Do an Advanced Search with criteria: Parts.Pending Change.Number is not null, select output 
fields: Pending Changes.Reason Code and Pending Changes.Change Category. 

6. You will see above values in the search results. 

7. Go back to Change Order Class, Cover Page, Change Category, Reason Code, select a different 
list (non-default list) and save. 

8. Log out, log back in, and go to the pending change created at step 3; modify the value for 
Change Category and Reason Code. 

9. Re-run the advanced search. 

10. The pending changes.change category and pending changes.Reason Code column values 
displayed the values you added in the step 8. 
 

 

19001992.6, 19011796.6, 19017912.6, 7161994.993 

Web Client 

Issue: In Web Client the Quick Search and the Parametric Search capabilities are not working. 

Root Cause: The baseClassMap function in editParametricsearch.inc was not handling the case 
when the base class is enabled, but has no enabled class under it. 

Resolution: Fixed the issue by bypassing the parametric search for this base class. 

Verification: Follow the steps below to verify the resolution: 

1. Log into Java Client and disable Package class. 

2. Log into Web Client, do Quick/Simple Search for any object with "*" or "P*". 
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3. Try to create a Parametric Search for Package. 

4. User is unable to perform a Parametric Search for Package, because there is no enabled class 
under Package base class. 
 

 

19004104.6

Folders, Files and Attachments 

Issue: The user is unable to undo the Attachment Redline or remove the redline file from the object. 

Root Cause: An error was thrown when the situation was encountered. 

Resolution: Replaced the error with a warning, changed the error message with new message. 

Verification: Follow the steps below to verify the resolution: 

1. Log into Web Client. 

2. Create a part and add attachments. 

3. Create a change and redline the files. 

4. Navigate to the part and select the Change from the drop-down list. 

5. Select the attachment row which has redlines. 

6. Click Remove.  

7. Appropriate warning message displays and then proceed with the deletion of that attachment 
row. 

 

 

19008354.6

Standard Reports 

Issue: Standard Reports do not respect discovery privilege properly creating a security issue. 

Root Cause: Calling one search API with the wrong parameter. 

Resolution: pass on correct parameter to search API. 

Verification: Follow the steps below to verify the resolution: 

1. Log in as Admin user, and create a new user 'guest'. 

2. Assign the user 'guest' some roles such as 'Report Manager, Report User, Item Content 
Manager'. 

3. Log back in as 'guest' and create an item PRT01. 

4. Log back in as the Administrator user and create an item PRT02 and add PRT01 as BOM. 

5. Remove the role 'Item Content Manager' from user 'guest' and add a report execution role to user 
'guest', such as "Report Manager" role. 

6. Log in as 'guest' and run Where-Used Report for PRT01 and the user should not be able to see 
part02 in the results of the search. 
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7. Open PRT01, go to its Where-Used tab and check results. Part02 should not be shown. 
 

 

19009538.6, 19356304.6, 6918012.994

Folders, Files and Attachments 

Issue: FileLoad fails when searching for files without FILE_INFO table in a DFM. 

Root Cause: In Web Client and SDK, the user cannot get the file the first time when the file is not in 
the preferred file server vault. 

Resolution: The issue was resolved by the implementation of other fixes. 

Verification: Follow the steps below to verify the resolution: 

Pre-condition: UserA with IFS and UserB with DFM. Set File Productivity to Advanced in Java 
Client. 

1. Log into Web Client with UserB (DFM user) 

2. Create a part and add attachments to it. 

3. Navigate to the database and remove the files added. 

4. Log into Web Client as UserA 

5. Search for the part added by UserB 

6. Try to Checkout the file. 

7. The file ID's have been removed from File_Info table and the appropriate error message displays 
without any error messages. 

 

 

19010164.6

Folders, Files and Attachments 

Issue: When viewing attachments the user receives the following error, “ORA-01747: Invalid 
User.Table.Column.” 

Root Cause:  "Checkout Status" is added to criteria, which in turn is added to Discovery Privileges for 
FileFolders. "Checkout status" was not having proper mapping to any column in 
"ATTACHMENT_P2P3" table. Due to this, the sql is failing, which in turn leads to failure of loading 
of the DiscoverBuilder object. 

Resolution: Mapped "Checkout Status" to the "Checkout_user" column of “ATTACHMENT_P@P3” 
table. If this column value is null, "Checked In" string is returned as value or "CheckedOut” string is 
returned. 

Verification: Follow the steps below to verify the resolution: 

Pre-Condition: Open Java Client and navigate to Admin > Data Settings > Criteria. Then create new 
criteria and set the Object type to "File Folders" and assign the attribute as "Title Block.Checkout 
Status equal to Checked In". Create a new privilege and assign the criteria to that privilege. Create 
a new Role and assign the privilege to that role. Create a new User and assign the role to that user. 
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1. Log into Web Client with that created user. 

2. Search for some Part/ FileFolder from Simple Search. 

3. The appropriate Part / FileFolder should be displayed in Simple Search window. No error 
messages are displayed. 

 

 

19011508.6, 6894792.994

Searches 

Issue: The system does not display the PIDs through the Advanced Search in the Affected Item tab. 

Resolution: The adding of new indexes made the query run faster. Before the fix, the query took 500 
seconds, but after the fix it took 230 seconds. 

Verification: Follow the steps below to verify the resolution: 

1. Log into Web Client and create a Change. 

2. Go to the Affected Items tab, do an Advanced Search and add an item. 

3. There is no error message. 
 

 

19011602.6

Searches 

Issue: Advanced Search behavior and Dashboard Configuration were irregular. 

Verification: Follow the steps below to verify the resolution: 

1. Log into Java Client as administrator and create a new user with Discovery Changes, Read 
Changes AppliedTo all attributes and Enforce Field Level Read privileges 

2. Create some Change Orders and add some Change Requests on the Relationship tab. 

3. The new user logs in, creates an Advance Search for Change Request > Relationship Search > 
Change Orders. 

4. Set the search criteria as Cover Page.Status in Pending, Submitted and CCB And 
Relationships.Change Orders.Cover Page.Originator in administrator. 

5. Select the Relationships object Cover Page.Number in the output display. 

6. Run the Search and the result displays the correct values. 
 

 

6917267.994, 6936822.994, 7058036.994, 7067000.994, 7094251.992, 7156827.994

Searches 

Issue: Running a search on the Where-used All Levels Latest Revision Only does not work and 
returns an unknown error. 
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Resolution: The issue was resolved by the implementation of other fixes. 

Verification: Follow the steps below to verify the resolution: 

1. Log into Java Client as administrator and create a criteria CRITERIA_001, with the attributes 
criteria as: "$CURRENTREV" equals to "$LATEST". 

2. Create a Read privilege and assign the new created criteria to this privilege. 

3. Assign this new privilege to the administratorA user. 

4. Log in as administratorA, create Part P001, and then add P002 as a BOM component of P001. 

5. Create a Change for P001 and route this Change to "Submit" status. 

6. Run a Where-Used search (Advanced Search) in both Java Client and Web Client, setting the 
Search Condition as "TitleBlock.Number" equal to "P002". 

7. Click "RUN" and the user can get P001 in the search results. 
 

 

6935417.993

Searches 

Issue: There is a significant time delay for the Home Page to load on the initial log in to the system. 

Resolution: The issue was resolved by the implementation of other fixes. 

Verification: Follow the steps below to verify the resolution: 

1. Create one File Folder -FOLDER001, go to its Routing Slip Tab, and add User A as an Approver. 

2. Log into Web Client with User A. 

3. The Home Page loads quickly and FOLDER001 should be listed on its Workflow Routing tab. 

4. Remain logged in as User A. Open FOLDER001 and approve this FileFolder. 

5. Go back to the Home Page. 

6. FOLDER001 should no longer be listed in the Workflow Routings tab. 
 

 

6940037.994

Searches 

Issue: There is an error with the Advanced Search results. 

Resolution: The issue was resolved by the implementation of other fixes. 

Verification: Follow the steps below to verify the resolution: 

1. Log into Java Client. 

2. Enable Parts Page Two.List01 and Page Two.Multilist01 using a same new list with entries "Yes, 
No". 

3. Create three parts, P1, P2 and P3, leaving the P1 Page Two.List01 and Multilist01 Null. 
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4. Input P2 attributes with value Yes, P3 with value No. 

5. Do an Advanced Search for Parts in both Java Client and Web Client using the below search 
criteria and output Page Two List01 and Multilist01: 

 Page Two.List01 Is Null. >>Search for P1 

 Page Two.List01 Is Not Null. >>Search for P2, P3 

 Page Two.List01 In "Yes".  >>Search for P2 

 Page Two.List01 Not In "Yes". >>Search for P1, P3 

 Page Two.List01 In "No". >>Search for P3 

 Page Two.List01 Not In "No". >>Search for P1, P2 

 Page Two.Multilist01 Is Not Null. >>Search for P2, P3 

 

7061802.994

Issue: There is a performance issue on the Workflow Routing table. 

7064918.992, 7197235.992, 7236117.994, 7242945.993, 7251603.992, 7263644.992, 7527789

cently Visited links for objects are incorrect for the user. 

n: 

 a low value, such as one minute. 

6. Log in with user2 and see the Recently Visited links also can be displayed correctly for user2. 

7073292.992

s an error with running an Advanced Search. 

 Page Two.Multilist01 Is Null. >>Search for P1 

 

 

Searches 

 

 

Web Client 

Issue: The Re

Root Cause: Getting the recently visited ID had some problem. 

Verification: Follow the steps below to verify the resolutio

1. Set the timeout to

2. Log in as user1. 

3. Log in as user2 in a separate window. 

4. Wait for the timeout (First user1 user will timeout, then user2). 

5. Log in as user1 and see that the Recently Visited links can be displayed correctly. 

 

 

Web Client 

Issue: There i
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Verification: Follow the steps below to verify the resolution: 

1. Log into Java Client, ena
Manufacture Parts, 

ble a Multi-List field on Part's Page two tab, assign list value as 
and then set the field as required. 

lient. 

cturer Part search window. 

s 'Manufacturer General Info.Name Is Not Null' 

r base class to class or subclass. 

1. The search will run successfully without an application error. 

 layout, not the Default sort order, has an error 
s occurred. Please contact your system 

 out of integer length. 

00148382-ER. 

re-Used Report with a layout that sorts by item number. Report should run without an 
rror. 

rch for parts with different search type results in 'NULL' error in Web Client for 
CAPA--AI tab. 
 

2. Log into Web C

3. Create a Part. 

4. Click on the '...' button and open Manufa

5. Click Create on the bottom left corner. 

6. Open the Manufacturer search window. 

7. Click on Advanced Search on top right corner. 

8. Enter in search criteria such a

9. Run the search successfully 

10. Repeat step 7 but change the search object from Manufacture

1

 
 

 

7085959.992

Standard Reports 

Issue: Running the Where-Used Report with a custom
return that reads, “ERROR: An unexpected error ha
administrator. Error Detail: For input string: “XXXX” 

Root Cause: Coding issue. The number is

Resolution: Use BigInteger to replace it. 

Verification: Follow the steps below to verify the resolution: 

1. Create an item CM3366000148382D with BOM item CM33660

2. Open CM3366000148382-ER and create BOM item 61.0266. 

3. Do steps 1 and 2 for other similar item numbers ending with 61.0266. 

4. Run a Whe
e
 

 

7100802

Web Client 

 Advance seaIssue:
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Integration 
18997098.6

SDK 

Issue: Running a query with a condition containing a “$” variable is not working. 

Root Cause: SDK passes relational operator identifier differently and status attributes are not special 
handled in Equal To and Not Equal To operations. 

Resolution: Added special handling for status attributes in Equal To and Not Equal To operations. 

Verification: Follow the steps below to verify the resolution: 

1. Create an ECO and do not assign any workflow. 

2. Create a query with condition "[Cover Page.Status] equal to '$UNASSIGNED'". 

3. Execute the query. 

4. ECO created in step 1 is available in query results. 
 

 

19003222.6

Import 

Issue: User is unable to import a BOM in Redlining mode. 

Root Cause: Import server fails due to "item.effective date" set as invisible. 

Resolution: Check if the "item.effective date" is visible before process. 

Verification: Follow the steps below to verify the resolution: 

1. Log into Java Client. 

2. Go to Admin > Classes > Item > Parts > General Information tab and disable Item.effectivedate 
field and save it. 

3. Log into Web Client. 

4. Import an item in redline mode with Change Order specified. 

5. Import of an Item should be successful. 
 

 

19009678.6

ACS 

Issue: The user receives the following error message: "More than 50 characters on ECO Submitted 
Subscriber are used in sentence. (Max is 50 characters)" 

Resolution: Increased the length of the ATO descriptions to 250 characters. 
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19011618.6, 7035484.993

Import 

Issue: Import specifically cannot save the mapping of a Price Line. 

Root Cause: The system has no Site license and Import tries to verify if Site field is provided in 
source file. 

Resolution: Not to continue to verify the field if there is no Site license (IPropertyDescriptor is NULL 
for this case). 

Verification: Follow the steps below to verify the resolution: 

1. Set No to Site in Licenses. 

2. Create an Import file with price.prices lines. 

3. Go to Web Client > Global import > Map the file. 

4. Able to import price with price lines and able to save the mapping file. 
 

 

19267710.6

Export 

Issue: The viewer cannot view the file properly from the export process when the file contains umlaut 
characters. 

Root Cause: When the export process was creating the PDX package, the attachment files were not 
being added correctly with respect to their file names, so characters such as umlauts were not 
properly handled. 

Resolution: Code was modified to properly handle characters such as umlauts within file names of 
attachments.  With this fix, Express is able to view and get the files from the PDX package correctly. 

Verification: Follow the steps below to verify the resolution: 

1. Create a file that has an umlaut in the file name. 

2. Add the file as an attachment to an item. 

3. Export the item, to PDX, including the attachment file. 

4. Open the PDX file in Express, go to the Attachment tab and click the View icon. 
 

 

6905591.994

Users 

Issue: The API is not fast enough in retrieving Users from a User Group. 

Root Cause: In the current design, it will fetch all user groups in the system first and then filter them 
according to the user ID. A lot of time will be used gathering user group information for the users if 
there are a lot of users and user groups in the system. 
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Resolution: Only return the user groups which the users belong to. 

Verification: Follow the steps below to verify the resolution: 

1. Create a Process Extension (PX) to retrieve Users from User Group and place .jar file on the 
server. 

2. In Java Client, configure the above PX. 

3. Initiate the PX from the Actions Menu and assign it to User Groups class. 

4. Create 50 users 

5. Create a User Group and add the above created 50 users to the Users tab. 

6. Execute the PX from the Actions menu of the User Group. 

7. It takes less than 5 seconds to retrieve 50 users from User Group. 
 

 

6960376.994

Import 

Issue: An invalid error message appears and then the user is unable to perform an import when 
using Level Template with a user that has Japanese Language Preference set. 

Root Cause: Import tries to verify if the level template source includes "Level" columns based on 
user's locale. The columns of old level template are fixed/uneditable. They should not be localized. 

Resolution: Verify the level based on localized "level" and non-localized "level". 

Verification: Follow the steps below to verify the resolution: 

1. Change the user's language preference to Japanese. 

2. Prepare level source file (Fixed column level template) as the following below: 

 Level | Item Number | Type | Description| Quantity 

 0      | P1                | Part   | TEST        | 1     

 1      | P2                | Part   | TEST        | 1 

 2      | P3                | Part   | TEST        | 1 

3. Import should be successful. 
 

 

7101437.994

SDK 

Issue: There was no documentation provided to explain that Workflow is a required attribute for 
using SaveAs on QCRs. 

Resolution: Added code to show how to perform this and text explaining that Workflow is a required 
parameter to save a QCR as another QCR or as an ECO in the section: "Saving a Quality Change 
Request as a Change" of the Oracle|Agile PLM 9.2.2.6 SDK User Guide. 
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7484540

ACS 

Issue: ACS is not compatible with Oracle Database JMS provider (AQ). 

Portlets 
19001178.6, 6882861.994

Issue: The user is unable to successfully delete notifications in Portal. 

Root Cause: Notifications use an identifier other than the primary key when performing delete, 
change status, and reload actions. The server requires the use of the primary key for performing 
these actions. 

Resolution: Modified notification to use the primary key when performing delete, change status, and 
reload actions. 

Verification: Follow the steps below to verify the resolution: 

1. In Java Client, set the Notifications as present in Inbox. 

2. Log into Portal and create 8 to 10 notifications to the login user. 

3. Log into Web Client and in the Notifications inbox try to delete two to three. 

4. Then log back into Portal and delete two to three notifications successfully. 

5. Open one of the subjects in notifications and there is no error. 
 

Product Collaboration 
18960388.6, 18979218.6, 19001840.6, 19003532.6

Java Client 

Issue: The user is unable to approve a change if the approves list contains a personal user group. 

Verification: Follow the steps below to verify the resolution: 

1. Log into Java Client. 

2. Create a Personal Group with a few members.  

3. Create a Change and fill in the required information. 

4. Route the change to the first Approve status. 

5. On the Address Book, click the User Group tab, and select Personal Group. 

 Personal Group with <Any> option should not work, and should therefore not be available to the 
user as an option at all. 

 Personal Group with <All> option works, and should continue to be supported and available to 
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the user. 

6. Select one user of Personal Group as an approver. 

e workflow Routing notification, open the change, and approve or reject the change 
uccessfully. 

 18969938.6

 an incorrect error in the OC4J log file that reads, “Error: Unknown number. 

roup, used user group ID to create cache of user, which lead to 

cide whether the ID is a user or user group and then deal with each situation 

eps below to verify the resolution: 

tatus.  

. Check the log file. There will be no incorrect error message displayed. 

 7038958.993

mote to the next status if $Approver has not added/removed the 

as not required. For default 

at was added in the fix. For special default approver 

low the steps below to verify the resolution: 

 rs", CCB: AutoPromote: Yes. Released.criteria: Approver: 

7. Log into Java Client as this user. 

8. Checking th
s
 

 

18965258.6,

Changes 

Issue: The user receives
Object does not exist.” 

Root Cause: When adding user g
Unknown Object exception. 

Resolution: De
respectively. 

Verification: Follow the st

1. Log into Java Client. 

2. Create a routable object and route it to Review s

3. Add a User Group as an Approver or Observer. 

4
 

 

18997072.6,

Changes 

Issue: A Change cannot Auto-Pro
Approvers/Observers Privilege. 

Root Cause: A previous fix introduced an extra privilege check which w
approver $OBSERVER, the system handled it as common approver 

Resolution: Remove only the privilege check th
$OBSERVER, handle it as default approver. 

Verification: Fol

Precondition: 

Workflow: "Default Change Orde
$APPROVER; 

1. Log into Web Client as administrator. 

2. Create a user with the following default Roles: 

 Creator can read and discover object he or she created; My User Profile  
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 Have read and discovery Changes, and has Approve / Reject Eng Changes Privileges. 

es 

5. For this ECO enter all required fields, switch from Pending to CCB status, and add New_created 

nt as New_created user and approve this ECO. The workflow status of this 
CO will automatically promote to Released status. 

 

Resolution: Change page header based on current displayed object. All files of print package are 

ps below to verify the resolution: 

a Change’s Affected Items tab (MCO). 

ck the print out page. The data should display correctly for each page. The first item is 
howing at the top of the first page only, instead of each page. 

 

6.6

Root Cause: Item.Manufacturer table row uses mfrpart as default row subclass, but for Manufacturer 

Resolution: When retrieving row subclass, if the attribute is Manufacturer read through attribute, 

y the resolution: 

c01 / 

3. Remove the below privileges: 

 Add Approvers / Observers for All Eng Chang

 Remove Approvers / Observers for Change 

4. Create a part; create an ECO against this part. 

user as Approver. 

6. Log into Web Clie
E

 

18999220.6

Java Client 

Issue: The first item shown at the top of each printed page is the same for multiple items. 

changed to support this. 

Verification: Follow the ste

1. Log into Java Client.  

2. Select multiple (2 or more) items from 

3. Right-click and select Print | All Tabs. 

4. Che
s

 

1899939

Items 

Issue: The Manufacturer. Page Two values do not display properly on the item's Manufacturer tab. 

read through attribute, the subclass should be Manufacturer instead of mfrpart. 

return Manufacturer instead of mfrpart. 

Verification: Follow the steps below to verif

1. Log into Java Client as administrator.  

2. Go to Class Settings and on the Manufacturer class enable Manufacturer.Page Two.List01 / 
MultiList01 / Text01 / MultiText01 / Numeric01 / Date01 Class Settings. 

3. Enable Part.Manufacturer.Manufacturer List01 / MultiList01 / Text01 / MultiText01 / Numeri
Date01. 
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4. Create a Manufacturer and specify values for above enabled fields.  

ove enabled fields. All the Manufacturer Page Two field values should be 
arried forward correctly. 

o redline an ECO’s BOM when the user does not have the Read Item 

ndled properly. 

rio correctly. 

1. M  have read item.BOM.site privilege and that the "Enforce Field Level 

I with a BOM.  

it the BOM and save. For the Site column in the Redline BOM tab, it will 
isplay No Privilege. 

etting the workflow field on changes. 

fy the resolution: 

2. O hange Order and set Change Order.AI.Item description as a required 

 description. 

5. Create a Manufacturer Part on this Manufacturer.  

6. Create a Part, add the newly created Manufacturer Part to its Manufacturer tab. 

7. Check the values for ab
c
 

 

19002884.6

Changes 

Issue: The user is unable t
BOM Site privilege. 

Root Cause: When user has no privilege on site column the case is not ha

Resolution: Added logic within the code to handle this scena

Verification: Follow the steps below to verify the resolution: 

ake sure user A does not
Read” role is assigned.  

2. Log in as user A to Java Client. 

3. Create an ECO and add an A

4. Try to redline edit the BOM. 

5. User can redline ed
d
 

 

19005410.6

Changes 

Issue: Entry required fields do not work for pending status of default workflow. 

Root Cause: Missing checking entry required fields when setting the workflow field on changes. 

Resolution: Added checking the entry required fields when s

Verification: Follow the steps below to veri

1. Log into Java Client as administrator. 

pen Workflow > Default C
field for Pending status. 

3. Log into Web Client as administrator. 

4. Create a Part, but do not type any

5. Create an ECO against this part. 

6. Specify "Default Change Order" as its workflow and click Save. 
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7. A warning message that reads, "Error: The following required fields are missing ... " will be 
p pted. rom

Note Check all PC/PQM routable objects (ECO, MCO, SCO, Stop Ship, Deviation, ECR, PSR, 
QCR). 

 

 

19005624.6

Items 

Issue: The user cannot access undeleted sites when performing a Recycle Bin search. 

1. W ill be removed from all users. 

, if a site is not in his/her site list, he/she cannot open this site and cannot 

Reso
 

 can use this column to save the information of soft delete. 

its couplings with a user, we just set all its 

4. If ver the coupling to positive 

e db, we still treat the user has the 

 to verify the resolution: 

4. It s, "Are you sure that you want to delete this object?" 

ll reset 

6. Click OK and you find that the new_created site will be removed from sites list of user A. 

nd the deleted sites. 

. You can "Delete, Undelete, Save As" successfully. 

r of workflows exceeds 19. 

Root Cause:  
hen a site is deleted, it w

2. For a user
undelete/hard delete it. 

lution:   
1. User/Site couples are saved in table USER_ASSIGNMENT, the column assignee_type is set as

user class 11605, we

2. If a site is soft deleted, we do not directly remove all 
couplings to -11605 

3. When it's hard deleted, we will remove the coupling 

 it's undeleted, we will reco

5. When load the site, if the site is soft deleted but still in th
privilege to load this site 

Verification: Follow the steps below

1. Make sure user A has 'Undelete Site' privilege. 

2. Login as user A to Web Client. 

3. Create a Site, and then delete a site through the Actions menu. 

 prompts a confirmation window that read

5. Click OK and it will prompt a window that reads, "Site has associated users. Removing wi
them. Would you like to continue?" 

7. Go to Recycle Bin Searches, open "Deleted Sites", and you will fi

8
 

 

6879380.994

Java Client 

Issue: The order of the workflows cannot be changed if the numbe
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Verification: Follow the steps below to verify the resolution: 

3. C Test: Pending, 
Released 

4. Click the Reorder Status button. You can see the new_created Status and also can reorder those 

5. C eges for changeorder_Test workflow, making sure user1 has this 
ege. 

 this new_created workflow status; also you are able to 
dvance from one status to another status. 

ich current user does not have privilege to Discover, consequent 

ntinue the loop of loading table when current user has no Discover privilege of current 

racted Manufacturer(2-test6/ag1l3).  

. Look at the redline. It should display the 'No Privilege'. 

hich caused ClassCastException 

he VOcellUser type and there is no longer the 

1. Log into Java Client as user1. 

2. Open Default Change Orders, save this workflow as changeorder_Test. 

reate more than 20 workflow statuses as shown below for changeorder_
Submitted (submitted1...submitted10), CCB (CCB1...CCB5), 
(Released1...Release5), Implemented, Canceled, and Hold. 

statuses. 

reate ChangeStatus privil
change status privil

6. Log into Web Client. 

7. Create an ECO and select changeorder_Test for the workflow. 

8. Go to the Workflow tab where you can see
a
 

 

7040283.993

Manufacturer 

Issue: A contract manufacturer is receiving a null error when trying to view redlines. 

Root Cause: For a redline row, wh
operation should not be done.  

Resolution: Co
redline row. 

Verification: Follow the steps below to verify the resolution: 

1. Log into Web Client as Cont

2. Search and open an ECO.  

3. Go to the Affected Items tab.  

4
 

 

7096667.992

Changes 

Issue: An error pops up while creating a part if the Page_Two.Create user is set as a required field. 

Root Cause: The original code did not handle type of VOCellUser, w
and blocks when objects such as Parts, ECOs, etc. were created. 

Resolution: Now the code does handle t
ClassCastException for that scenario. 
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Verification: Follow the steps below to verify the resolution: 

nable Page_Two.Create User, 
er as a required field.  

lly. 

 sam

Note ist is set to User list and required field, it also is 

1. Log into Java Client as Administrator user.  

r Interface tabs > Page Two, e2. Go to Classes > Parts Class > Use
and make Page_Two.Create us

3. Create a New Part successfu

4. Save this part successfully. 

5. Do e operation for Change Orders; it should be created and saved successfully. 

Create/SaveAs Change if P2.List/MultiL
created and saved successfully. 

 

Product Cost Management 
7181976, 7195514

t 

changes 

d Manufacturer Parts 

verify the resolution: 

CO. 

r the Program in General Info page. 

pliers. 

ppliers. 

and Custom Report. And it is pulling the prices according to the criteria given in the query. 

Prices/PCOs 

Issue: Duplicate price lines are created when republishing responses from a sourcing projec

Root Cause: Loading of the price table was not properly handling price lines under 

Resolution: Fixed the loading of the price tables for Items an

Verification: Follow the steps below to 

1. Create an Item (P1) with the AML 

2. Add the AML through an ECO and release the E

3. Create a Sourcing Project and add the Item P1. 

4. Make sure that you have given a value fo

5. Create a RFQ and send it to Sup

6. Get Responses from Su

7. Go to the Analysis tab. 

8. Publish the Price as contract price in Redline mode and release PCO. 

9. Repeat the above step and publish the price (contract price) twice and release all PCO's 
accordingly. 

10. Re-Publish the Price as Published Price in Redline mode and do not release the PCO. 

11. Create Custom Report with the following query:Parts.Prices.Part Type='contract' AND 
Parts.Prices.Program='program1' AND Parts.Prices.Mfr Part Number='Not Null' 

Report and check the Prices. There are no duplicate lines displayed in Items.Prices tab 12. Run the 
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7520302

Reports/Import/Export 

Issue: Assembly rollup cost report does not generate consistent results. 

Root Cause: Lookup was considering price=0 from history as valid when there are no response(s) in 
item/AML yet, but ignored price=0 from the history if there are response(s). Also, filter was not 

kup to always ignore price=0 and fixed getting selected items/AML by applying 

n: Follow the steps below to verify the resolution: 

d other is a non-zero value. 

5. Do the "Ro Sourcing Project Actions Menu and the system will not pull 
the zero Material Price. 

pplier 

ract price (Supplier02) with a Material price of $.10. 

shed price" and supplier S1 

8. D
the zero Material Price and consistent results are be returned if user does the same steps more 
than once. 

1. D t Actions Menu after 
nd consistent 

results will be returned if user does the same steps more than once. 
 

working properly during lookup. 

Resolution: Fixed loo
in-memory filter. 

Verificatio

Case 1: 

1. Create an item with an AML. 

2. Create two prices for the AML where one is "0" an

3. Create a sourcing project and add this item to it. 

4. Go to the Analysis tab and do a lookup. The system will not pull the zero price. 

llUp Cost" action from the 

 

Case 2: 

1. Create an item with two AMLs (P1AML1, AML2). 

2. Create two prices - Published price (Supplier S1) with price of $0.20 and Contract price (Su
S2) with price of $0.05. 

3. Create a price for AML2 which is a cont

4. Create a Sourcing project and add P1. 

5. Do a global select in the Analysis tab and do a lookup. Choose "publi
as the lookup criteria. 

6. Apply "parts w/o supplier" which will display only one AML (AML2). 

7. Do a global select again and do a lookup. Select "contract" in price type and supplier S2 as the 
lookup criteria. The system will pull prices correctly even after filtering. 

o the "RollUp Cost" action from the Sourcing Project Actions Menu and the system will not pull 

 

Case3 : 

o the "RollUp Cost" Action (more than once) from the Sourcing Projec
doing the above steps and the system will not pull the zero Material Price a
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Product Portfolio Management 
18992408.6, 19001180.6

Content Management 

Issue: There are security gaps in the Project Summary page. 

Resolution: Added a privilege check in the createValueObject() method. Now it checks if the user has 
both Read and Get privileges before displaying the "Open" hyperlink. However the user can still 
add/remove objects from the important content view even without the privileges. 

Verification: Follow the steps below to verify the resolution: 

1. Log in as administrator, create a program P1 and add a subtask. 

2. Go to the Content tab of the root and add a filefolder as it's content. 

3. Select the content and add to important content view. 

4. Create a user in Java Client with following privileges: Discover and Read programs, Discover 
filefolders. 

5. Log in as the newly created user and search for the above program.  

6. In the Summary page, check for the file in Important Content widget. 

Note File name is seen but Open appears as “No Privilege” 

7. Go back to Java Client and now add the following privileges: Read filefolder, Get filefolder, View 
filefolder, Add get filefolder on programs and read filefolder on programs. 

8. Log in as the above user, search for the program P1 and on the summary page, from the 
Important content widget user can get file using the Open option. 

 

 

18998110.6, 19005332.6

Web Client 

Issue: When adding news to a project item, the user can choose the owner in an editable field, but 
this field should default to $USER and should not be editable. 

Root Cause: None of the default values are being displayed when 'Create' news button is clicked, 
including for the owner attribute.  

Resolution:   
1. The default value for 'Owner' attribute in News tab during create should be '$User' and for Date 

should be current Date and should not be editable. Other attributes should take the defaults. 

2. UI has to make a load table with a dummy table ID (similar to Action Items) to get the default 
values from the server and display the page accordingly.  

3. Server has to support the new dummy table ID and return IBaseClientTable that has single row 
with Default values for all the enabled attributes in News Tab. 
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Verification: Follow the steps below to verify the resolution: 

1. Log into Web Client and create a program. 

2. Go to the News tab and click on Create. 

3. Check the Owner field to see the Owner field is not editable.. 
 

 

18999544.6, 19002662.6

Web Client 

Issue: There is an error message 0 when launching one project in MSP edit mode. 

Root Cause:  The updateDependenciesForTask() method does not handle the indirection (getting the 
unique sequence number from activityUIDMap) for predecessors. If the predecessor is not present 
in the subtree of the selected task then the ID corresponding to the predecessor will be missing in 
activityUIDMap. Hence the value returned from the map will be NULL and parsing NULL to integer 
throws ParseException which is displayed as NULL in UI. 

Resolution: In the method updateDependenciesForTask() always all the dependencies (predecessor 
links) are first deleted and then created again instead of updating them. 

Verification: Follow the steps below to verify the resolution: 

1. Create a program with two sub tasks (P1 and P2) 

2. Add subtasks to P1 and P2 and create dependencies between subtasks of P1 and P2. 

3. Launch P1 from the Actions menu > Microsoft Project > Launch in Edit Mode. 

4. Publish back to PPM from MSP. 

5. Repeat steps 2 and 3 several times and there is no error message. 
 

 

18999914.6

Web Client 

Issue: Creating a program from the template does not get the default value in the Description field. 

Root Cause: The new program will always be created with the description filled in by the user in the 
"Create from Template" wizard page. The description of the selected template is not displayed in 
the "Create from Template" wizard and then the creation of the description of the new program will 
be always be empty. 

Resolution: The description of the selected template should be displayed in step 2 of the "Create 
From Template" wizard. User can alter the description if required. When finished, the new program 
will be created with the description as displayed (altered description is modified by the user) in the 
wizard page. 

Note If the description of the selected template is EMPTY and the default value is configured for 
'Description' attribute, then EMPTY will be displayed in the wizard page and the finished 
new program will be created with an EMPTY description. This behavior change will be 
only for "Create from Template" operation and not for the SaveAs operation. 
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Verification: Follow the steps below to verify the resolution: 

1. Log into Web Client as administrator and create a template. 

2. Give some description for the template. 

3. Now create a program from the above template. 

Note: Description of the template is seen in the “Create Program from Template” wizard 

4. Select the above created template and click Next. 

5. The description of the template appears here and on saving, the above program will have the 
correct template description. 

 

 

19004494.6

Web Client 

Issue: In PPM there are different browser windows opening when changing the Due in Days value 
on the Summary page. 

Root Cause: The target pane was not getting set properly. 

Verification: Follow the steps below to verify the resolution: 

1. Open a root program.  

2. In the Summary page, go to Upcoming Activities and Action Items. 

3. Change the Due in Days value in Upcoming Activities and Action Items and hit Enter. 

4. The same page is refreshed to reflect the change and does not open a new browser. 
 

 

19005532.6

Web Client 

Issue: PPM Hyperlink does not work if the user is already logged in. 

Verification: Follow the steps below to verify the resolution: 

1. Create a program P1 with subtasks. 

2. Go to the Summary Page of P1 and copy the url using Actions > Copy URL to clipboard. 

3. Log out and close the browser 

3. Open a new browser and paste this URL into the browser and click Enter. 

4. The user is taken to P1 Summary Page. 
 

 

19005884.6

Gantt 

Issue: The desired settings for the Gantt Chart are not saved correctly for header and footer field 
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settings. 

Verification: Follow the steps below to verify the resolution: 

1. Launch Gantt Chart for a program. 

2. Select File > Page Setup. 

3. Select Header/Footer option and go to the Custom header tab. 

4. Select left section and change font; click OK until you are out of the page setup.  

5. Select Format > Save settings. 

6. Close Gantt and re-launch. Go to Page Setup and note that the change made to the font is 
saved.  

 

 

6946803.994

Schedule Management 

Issue: User is able to open the task beneath the current phase even though the Gate task is not 
open. User does not want a task to be in Progress before Gate1 is opened. 

Root Cause: In the initial implementation, a status change of a child object was honoring the 
deliverables on the parent object too, but it was eventually changed. According to that, the status 
change of a parent to In Process is allowed even if the deliverables on the parent are not complete 
as part of the child status change. Deliverables on the parent are honored only when the parent's 
status has to be changed to complete as part of child's status change. 

Resolution: Added pe.checkParentDeliverables property in agile.properties file. By Default it is set to 
false. If the user wants Parent deliverables to be checked even for In Process state, 
pe.checkParentDeliverables needs to be set to true. 

Verification: Follow the steps below to verify the resolution: 

1. Set pe.checkParentDeliverables=true in agile.properties. 

2. Create a program. Add a phase P1 and a Gate G1. 

3. To the phase P1, add a child T1 and go to the Content tab of P1. 

4. Go to content by search and add G1. 

5. Set a rule: When G1 is open, set P1 to In Process. 

6. Now go to T1 and change status to In Process. 

7. Add Approvers/Observers and click OK. 

8. An error message appears saying that " Not all dependencies in the Relationships/Deliverables 
table have reached the trigger status." 

 

 

6973691.994

Gantt 

Issue: Performing a SaveAs for a new template from the Gantt fails with an error, “!Activity does not 
exist,” when using a GCX file. 
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Root Cause: Create from Template field of the file will still have the value of T1 which was hard 
deleted. This is incorrect logic and behavior. 

Verification: Follow the steps below to verify the resolution: 

1. Create a Template T1. 

2. Create a program P1 from T1. 

3. Launch Gantt for P1 and save a file for P1 as P1File.gcx.  

4. From Web Client hard delete T1.  

5. From Gantt Open file P1File.gcx and perform a SaveAs. 

6. The new program is created successfully. 
 

 

6973836.994

Gantt 

Issue: The Gantt Chart does not set Defaults properly which are defined in the Java Client. 

Root Cause: Gantt was initially implemented without populating default values for new activities. 

Resolution: Gantt will now be able to create activities with default values. 

Verification: Follow the steps below to verify the resolution: 

1. Go to Java Client > Admin > Classes > Activities > General Info Attributes tab. 

2. Make one of the list items (Rollup Health Status) default set to No. 

3. Open a Program in the Gantt Chart client. 

4. Go to a Phase and insert a new activity (Task) using the following menu Edit > Insert > Activity. 

5. Enter a new name for the task. 

6. The roll-up health status value in the Properties is set to No as the default value in Java Client. 
 

 

6984554.993

Costing 

Issue: The Program Resource Utilization Report is not in English. The user needs to know how to 
change the options so that the language is English for this report. 

Root Cause: In customTimeFormat, DateFormat was constructed to set the format String because of 
which Time Zone (Language) the machine was set to. 

Resolution: In CustomTimeFormat (ResourceUtilizationPanel, ChartServletSupport) need to use the 
DateFormat passed to the function as it will have the preferred language set on it, instead of 
constructing new SimpleDateFormat. 

Verification: Follow the steps below to verify the resolution: 

1. Log into Web Client as a user with the preferred language set to English. 
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2. Create a program with duration of more than one year. 

3. Invoke Program Resource Utilization Report from Actions Menu > Reports and Analytics 

4. Click on Show Report options. 

5. Change Report intervals to Month or Quarter and click Refresh. 

6. All months are displayed in the preferred language. Change preferred language of user and 
check again. 

 

 

7279841

Gantt Chart 

Issue: In Gantt a null pointer exception is displayed if the user enters special characters (/,*) in Date 
field from program information wizard. 

Root Cause: All dates are first checked if they are in the correct format, but if they are not, an error 
message is displayed to the user. 

Resolution: The check has been put in the stopCellEditing() method. 

Verification: Follow the steps below to verify the resolution: 

1. Log into Web Client. 

2. Create a program and add a phase and a gate to it. 

3. Launch the Gantt from the root menu. 

4. Open the program information wizard for the phase. 

5. Edit the value for the actual start date, press Enter and then click OK. 

6. Check the stack trace. There is no error and the user is able to enter actual start date without any 
errors. 

 

 

7279868

Gantt Chart 

Issue: A pop-up telling the user that the update failed displays when the user deletes and hits update 
in Gantt Chart 

Verification: Follow the steps below to verify the resolution: 

1. Log into Web Client. 

2. Create a program. 

3. Add a phase and gate. 

4. Launch the Gantt from the root menu. 

5. Edit the actual end date for the gate from the program information wizard and click OK, but do not 
update. 

6. Again open program information wizard and clear the date field and click OK. 
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(Note: It will display an error message on status bar.) 

7. Enter a different date and click OK. 

8. Then delete the gate and hit update. The program is updated and there are no errors. 
 

Product Quality Management 
19001174.6

Corrective Action 

Issue: User needs to be able to configure multilists and multitext fields in the Affect Item tab of a 
routable object to contain a greater number. 

Root Cause: New Feature/ Enhancement. 

Resolution: Added 15 multilist and 15 multitext to Change/PSR/QCR objects. 

Verification: Follow the steps below to verify the resolution: 

1. Log into Java Client as administrator. 

2. Open Class Settings > Change Orders > Affected Item. 

3. Check the number of Multilist and Multitext; there will be 15 AI multilist fields and multitext field. 

4. Enable all multilist and specify List for them; the specified default value will be initialized when an 
AI is added. 

5. Enable all multitext and specify default value for them; the specified default value will be 
initialized when an AI is added. 

6. Test above operations for all the following objects, they should work well. 

 PSR 

 QCR 

Change objects (ECO, MCO, SCO, Stop Ship, Deviation, ECR) 

 

19004474.6

Corrective Action 

Issue: The user is able to view PSRs through a supplier object. 

Root Cause: System is returning wrong discovery object in PSR tab of Suppliers. 

Resolution: Return right discovery object in PSR tab of Suppliers. 

Verification: Follow the steps below to verify the resolution: 

1. Log into Java Client as administrator. 

2. Create a role and assign the following privileges: 

 Discover All Suppliers 
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 Read All Suppliers  

3. Create a new user (UserA) and assign only this role and the default roles.  

4. Create a Problem Report and select supplier (SupplierA) on its Cover Page.  

5. Log into Web Client as UserA. 

6. Search PSRs by *. It should prompt the following message: "There are xxx row(s) missing in this 
table due to insufficient user privileges." 

7. Search Suppliers by * and all existing suppliers will display. 

8. Open SupplierA and go to the PSRs tab to check the value on the PSRs tab. It should prompt the 
following message: "There are 1 row(s) missing in this table due to insufficient user privileges." 

 
 

Technology Platform 
18922850.6, 18924064.6, 18944402.6, 18948172.6, 18959520.6, 18960530.6, 18960838.6, 18962260.6, 18968440.6

Security 

Issue: The User Monitor is still showing user sessions which were terminated by the system.  

Root Cause: The actual logout was happening after the session-timeout of two minutes but the user 
was able to see abc user in the User Monitor due to the saveRecentlyVisited(..) call that was 
happening in the apcm\src\com\agile\ui\pcm\login\LoginHandler.java and it eventually called the 
checkPermissionAndRegister(..) in the 
apcm\src\com\agile\common\server\security\monitor\UserSessionDAO.java. Then it was adding a 
new row for the abc user with the hardcoded session-timeout of ten minutes and then the 
"Unknown" was getting shown in the host column. 

Resolution:  The fix is to not show the rows that are having the host name as "Unknown”. Add the 
condition AND a.host != 'Unknown' in the SQL which was there in the API public static 
VOSessionInfo[] retrieveSessions(). 

Verification: Follow the steps below to verify the resolution: 

1. Change the session-timeout to two minutes in web.xml and start the server. 

2. Log in as administrator to Java Client and open the User Monitor in the user settings and you can 
see administrator here. 

3. Log in as user abc to Web Client and observe the User Monitor by refreshing, you can see 
administrator as well as abc. 

4. Wait for two minutes and check even if the session times out also you can see the abc in the 
User Monitor with "Unknown" host. Now the User Monitor will not show the "Unknown" hosts. 

 

 

18972952.6, 18977182.6, 18981150.6, 18982646.6

Security 

Issue: After the user logs in the User Monitor shows the user’s host as “Unknown”. 
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Verification: Follow the steps below to verify the resolution: 

1. Log into Java Client as administrator from PC1. 

2. Go to User Monitor. 

3. Log into Java Client as user1 from different PC (PC2). 

4. You will see 'user1' logged from 'PC2' from User Monitor. 

5. Keep Java Client logged in by user1, and stop operation for about an hour. 

6. Check User Monitor from Java Client logged in by administrator user. 

7. Notice that host name of 'user1' now displays as 'Unknown'. 

8. Try to do some operation through Java Client logged in as user1. Notice that you can continue 
operation without getting error message of session. 

9. Go back to User Monitor logged in as administrator user and there is no Unknown session 
displayed. 
 

 

18998902.6

LDAP 

Issue: Duplicate users in two LDAP were not getting synchronized properly. With the same user ID 
existing in two LDAP sources, the Agile account is not updated in an LDAP synchronization. 

Verification: Follow the steps below to verify the resolution: 

1. Set an Agile PLM to use one LDAP source. 

2. Synchronize the LDAP. 

3. Add a second LDAP source. 

4. Change some data in the first LDAP source, such as the phone or title. 

5. Synchronize the LDAPs again. 

6. User should get a warning: Following users were not updated because they have duplicate user 
IDs: XYZ_2. 

 

 

19410862.6

Application Server 

Issue: After undeploying Agile and installing a certified patch, deploying Agile fails. 

Verification: Follow the steps below to verify the resolution: 

1. Install the Agile9224 > Agile9226 application. 

2. Go to <AgileHome>\agiledomain\applications> and open application.ear or in the deployed 
location <OracleHOME>j2ee\home\applications>Agile.ear file. 

3. User should not see the folder link along with the link.war. 
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7204469

LDAP 

Issue: Roles are not inherited properly from a User Group when the group is soft-deleted. 

Root Cause: For LDAP users the roles were inherited from group despite making the group inactive 
in Agile. This was because the even inactive groups were being considered to inherit the roles from 
them. 

 

7211148

LDAP 

Issue: All the mapped P2 attributes are not shown if the user has mapped more than 5 attributes in 
Java Client. 
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Known Issues 

This chapter includes the following: 

 Known Issue Disclaimer ...................................................................................................................................... 43 
 Install and Upgrade.............................................................................................................................................. 43 
 Technology Platform............................................................................................................................................ 44 

This section contains a list of known issues for this release. These were deferred from this release, 
but may be fixed in a future release. Numbers in this section are for Oracle|Agile internal use only. 
 

Known Issue Disclaimer 
This list of Known Issues consists of those found at the time of the initial release. The product may 
have additional issues found after the initial release and therefore this list is subject to change and 
is not always comprehensive. Oracle support will continue to track known issues of this product 
release found on MetaLink. Please check for updates. 
 

Install and Upgrade 
8353452

Service Pack Installer 

Issue: A 9224L10N GA build with a CH/JP/TC OS cannot be updated to the 9226NLS build. 

Workaround: 

Manually add the server configuration information, found below, in English for environments of WLS 
and OAS before upgrading the build on JP/CH/TW OS from the 9224NLS build to the 9226NLS 
build. Please modify the English code found below with the correct server configuration and add the 
modified code into the head of agile_app.cfg, agile_api.cfg, agile_dfm.cfg, agile_ws.cfg, etc. files. 

OAS: 

Application Server Type=oas 

Application Server Host=@APP_SERVER_HOST_NAME@ 

Application Server Virtual Path=@APP_SERVER_VIRTUAL_PATH@ 

Clustered=@CLUSTER_INSTALLED@ 

OAS Home=@OAS_HOME@ 

OAS HTTP Listen Port=@OAS_LISTEN_PORT@ 

Web Server Host=@WEB_SERVER_HOST_NAME@ 

Web Server Port=@WEB_SERVER_PORT_NUMBER@ 
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WLS: 

Application Server Type=wls 

Application Server Host=@APP_SERVER_HOST_NAME@ 

Application Server Virtual Path=@APP_SERVER_VIRTUAL_PATH@ 

Clustered=@CLUSTER_INSTALLED@ 

BEA Home=@BEA_HOME@ 

Where you installed BEA application server Listen Port=@BEA_LISTEN_PORT@ 

Web Server Host=@WEB_SERVER_HOST_NAME@ 

Web Server Port=@WEB_SERVER_PORT_NUMBER@ 
 

Technology Platform 
7610913

Operating System 

Issue: After a time-out, a re-activated Java Client user session is not displayed in the User Monitor. 

Steps to Reproduce:
1. Log into Java Client with administrator user.  

2. Go to the User Monitor node and see the current user session displayed. 

3. Do not log out, but leave Java Client without any action for 24 hours so that Java Client times out 
the user session. 

4. Make sure that the administrator user session from step 1 is the only user session on this Agile 
System. There should be no other users logged into this environment. 

5. Go back to the User Monitor page. 

6. Click Refresh to get the latest results. 

7. No user session will be displayed after a refresh. However, since current user is still logged on 
and doing actions in Java Client the current user session should be displayed by the User Monitor. 

Workaround: No workaround solution is available. 
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